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Preface

This guide explains how to upgrade your existing Oracle WebLogic Portal installation 
to the latest version of Oracle WebLogic Portal. 

Audience
The tasks described in this guide are typically performed by portal administrators, 
system administrators, and/or database administrators. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call 
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle 
technical issues and provide customer support according to the Oracle service request 
process. Information about TRS is available at 
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone 
numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.



x

Related Documents
For more information, see the following documents in the WebLogic Portal 
documentation set:

■ Oracle Fusion Middleware Release Notes for Oracle WebLogic Portal

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.



1

Overview of the Upgrade Process to WebLogic Portal 10.3.2 1-1

1Overview of the Upgrade Process to
WebLogic Portal 10.3.2

This section provides an overview of the strategies and procedures for upgrading 
Oracle WebLogic Portal to 10.3.2. You can upgrade directly to Portal 10.3.2 from the 
following WebLogic Portal applications:

■ Oracle WebLogic Portal 10.3

■ Oracle WebLogic Portal 10.2

■ Oracle WebLogic Portal 10.0 and 10.0 Maintenance Pack 1 (MP1)

■ Oracle WebLogic Portal 9.2 and 9.2 MP1

■ Oracle WebLogic Portal 8.1 SP4, SP5, and SP6 

You are not required to upgrade from WebLogic Portal 8.1 to 9.2, from 9.2 to 
10.0/10.2/10.3, and then from 10.0/10.2/10.3 to 10.3.2.

The following topics are covered in this chapter:

■ Section 1.1, "Definitions"

■ Section 1.2, "Portal 9.2, 10.0, 10.2, 10.3 to 10.3.2 Upgrade Overview"

■ Section 1.3, "Portal 8.1 to 10.3.2 Upgrade Overview"

■ Section 1.4, "Library Module Changes"

■ Section 1.5, "Supported Features Comparison"

■ Section 1.6, "Security"

■ Section 1.7, "Event Handling"

Note: If you are upgrading a WLP application that uses Autonomy 
Enterprise Search and you would like to continue to use Autonomy 
Enterprise Search, you must first purchase the required license and 
obtain the binaries from Autonomy Corporation at 
http://www.autonomy.com. For more information on using 
Autonomy with WLP, see Oracle Fusion Middleware Autonomy Search 
Integration Sample Guide for Oracle WebLogic Portal. 

You can also elect to use another search engine in place of 
Autonomy, such as Oracle’s Secure Enterprise Search, which can be 
purchased separately or comes as part of WebCenter Suite.
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Some of tasks associated with a WebLogic Portal upgrade are performed by running 
the WebLogic Upgrade Wizard. The WebLogic Upgrade Wizard is described in Oracle 
Fusion Middleware Upgrade Guide for Oracle WebLogic Server. 

1.1 Definitions
To clarify the different activities described by this document, a brief list of terms is 
included:

Migration – Moving an application and domain from a third-party technology to an 
Oracle product. (For example, migrating a customer from IBM to Oracle.)

Upgrade – Updating Oracle platform (and components) from older release or Service 
Pack to newer release or Maintenance Pack. This includes updating existing 
application and domain to run in a newer version, for example, 9.2 MP1 to 10.3.2.

The process required to upgrade an application environment depends on the scope of 
the application. An application environment includes a WebLogic domain and any 
applications and application resources associated with the domain. It may also include 
external resources, such as firewalls, load balancers, databases, and LDAP servers.

Interoperability – (1) The capability of an application deployed in one release or 
service pack to communicate with another application that is deployed in a different 
release or service pack. (2) The capability of WebLogic Platform components to 
communicate with third-party software using standard protocols.

Compatibility – Application built using one release or Service Pack running in 
another release or Service Pack. This might involve rebuilding the application.

1.2 Portal 9.2, 10.0, 10.2, 10.3 to 10.3.2 Upgrade Overview
You can upgrade your WebLogic Portal 9.2, 9.2 MP1, 10.0, 10.0 MP1, 10.2, and 10.3 
applications to 10.3.2. The upgrade process involves upgrading your WebLogic Portal 
domain and applications. Upgrade the portal domain using the WebLogic Upgrade 
Wizard before you upgrade your portal application. The upgrade procedure is 
explained in Chapter 2, "Upgrading to WebLogic Portal 10.3.2." 

The WebLogic Portal APIs have been maintained in the current version of WebLogic 
Portal (except for the Commerce API, which was deprecated in 10.0 and removed from 
the current version), and most core formats for the database and file based assets have 
not changed. Where changes have been made, tools are provided to upgrade you to 
the new format, or provide manual changes where needed. 

The 9.2 and 10.0/10.2/10.3 upgrades are performed on a .project file. After you 
upgrade to Portal 10.3.2, you cannot go back to a previous portal version. If you are 
upgrading from WebLogic Portal 9.2 or 10.0/10.2/10.3 to 10.3.2, the PointBase 
database version has already been upgraded.

You can choose one of the following methods to upgrade your Portal 9.2 or 
10.0/10.2/10.3 application to 10.3.2:

■ Open an existing 9.2 or 10.0/10.2/10.3 portal application as a workspace in 
Workshop for WebLogic

■ Import an existing exploded 9.2 or 10.0/10.2/10.3 project into Workshop for 
WebLogic

■ Import an archived 9.2 or 10.0/10.2/10.3 project file into Workshop for WebLogic
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For instructions on upgrading, see Section 2.6.2, "Upgrading from Portal 9.2 and 
10.0/10.2/10.3 to 10.3.2."

1.3 Portal 8.1 to 10.3.2 Upgrade Overview 
WebLogic Portal enables you to upgrade your 8.1 SP4, SP5, and SP6 applications 
directly to 10.3.2. Most WebLogic Portal APIs have been maintained in the current 
version of WebLogic Portal (except for the Commerce API, which was deprecated in 
10.0 and removed from the current version), and most core formats for the database 
and file based assets have not changed. Where changes have been made, tools are 
provided to upgrade you to the new format, or provide manual changes where 
needed.

The upgrade process involves upgrading WebLogic Portal 8.1 portal applications and 
resources to WebLogic Portal 10.3.2. The 8.1 to 10.3.2 upgrade is performed on a 
.work file. If you customized how you set the domain in your start scripts, your 
changes will be overwritten when you run the WebLogic Portal 10.3.2 start scripts.

For instructions on upgrading, see Section 2.6.3, "Upgrading from Portal 8.1 to 10.3.2."

1.4 Library Module Changes
The Domain Upgrader tool is responsible for adding or removing library modules, as 
necessary. It also modifies existing library module path information to point to the 
new product installation.

Removed libraries are deleted from the config.xml file. If you upgrade from 8.1.x to 
10.3.2, the libraries are added to your config.xml file. If you upgrade from 9.2 or 
10.0/10.2/10.3 to 10.3.2, the module version number changes to 10.3.2 in your 
config.xml file. If you upgrade from 10.0 MP1 to 10.3.2, the domain upgrader 
removes the maintenance-lib references.

1.5 Supported Features Comparison
This section outlines significant feature changes between older version of WebLogic 
Portal and the Portal 10.3.2 release.

1.6 Security 
WebLogic Portal 8.1 included a WebLogic Portal-specific RDBMSAuthenticator. This 
has been deprecated. WebLogic Server 9.2 contains a new default SQLAuthenticator 
authentication provider, which contains an RDBMS user store for users and groups. 
Oracle recommends upgrading to the new WebLogic Server SQLAuthenticator.

NOTE from Steve

When you run the WebLogic Upgrade Wizard to upgrade your domain, it determines 
whether or not you are using the RDBMSAuthenticator in your 8.1 installation. If the 

Tip: You cannot upgrade an existing EAR application; only a project 
can be upgraded.

Note: When you upgrade from WebLogic Portal 8.1 to 10.3.2, your 
PointBase database is upgraded. 
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RDBMSAuthenticator is detected, the WebLogic Upgrade Wizard prompts you to 
choose whether to upgrade to the WebLogic SQLAuthenticator as your default 
authentication provider or continue to use your existing RDBMS user store. Replacing 
the existing authentication provider with the new WebLogic Server SQLAuthenticator 
upgrades all content, including personalization features. You can also choose to 
manually upgrade your personalization features to the Portal 10.3.2 RDBMS user store 
later.

Choose one of the following options when upgrading your user store:

■ Upgrade users and groups – Choose to automatically upgrade your users and 
groups from WebLogic Portal 8.1 to the new RDBMS user store, which is part of 
the new default WebLogic SQLAuthenticator authentication provider. When you 
run the WebLogic Upgrade Wizard and it detects the Portal 8.1 
RDBMSAuthenticator, you can select the Upgrade RDBMSAuthenticator option. 
Selecting this option replaces the existing authentication provider with the new 
SQLAuthenticator authentication provider and upgrades your user store, 
including users and groups. Your config.xml file is also updated.

■ Do not upgrade users and groups – Choose to continue to use the RDBMS user 
store from the default RDBMSAuthenticator in your WebLogic Portal 8.1 
installation. When you run the WebLogic Upgrade Wizard and it detects your 
Portal 8.1 RDBMSAuthenticator, you can select the Do not upgrade 
RDBMSAuthenticator option. You can choose to manually upgrade your users and 
groups to the Portal 9.2 RDBMS user store later.

If you do not upgrade your user store during the domain upgrade process, you can 
perform a manual upgrade later. The script to upgrade from the WebLogic 
Portal-specific RDBMS Authenticator to the WebLogic SQL Authenticator is 
<WLPORTAL_HOME>/p13n/db/<dbms>/upgrade_fromdbmsauth_ 
towlssqlauth.sql.

For additional information, see Section B.2, "Upgrading 8.1, 9.2, or 10.0 PointBase 
Databases."

When you upgrade your domain to 10.3.2, the RDBMS Security Store is not enabled by 
default. To enable and configure the Security Store, you must use the Oracle WebLogic 
Server Administration Console. For detailed information on the RDBMS security store, 
see the WebLogic Server document, "Managing the RDBMS Security Store," in Oracle 
Fusion Middleware Securing Oracle WebLogic Server.

When upgrading a WLP domain to 10.3.2, if you also want to use the RDBMS Security 
Store, after performing the upgrade you must configure the RDBMS Security Store 
using the WebLogic Server console. After restarting the domain, policies are 
auto-migrated into the RDBMS security store. If you instead want to migrate policies 

Note: If you upgrade a WebLogic Portal 8.1 application to 10.3.2 and 
you use the UserProviderControl.createUser() class in the upgraded 
domain, you might see a javax.security.auth.login.LoginException 
error when a new user attempts to log into WebLogic Portal. This 
occurs because by default new users in a WebLogic Portal 10.3.2 
domain are created in the SQLAuthenticator and not in a migrated 
authentication provider (which normally is configured with a JAAS 
flag set to REQUIRED). Since the WebLogic Portal domain Upgrade 
Wizard does not adjust your JAAS settings or remove your existing 
authentication provider, you must adjust the JAAS setting or delete 
the authentication provider (as appropriate) to avoid this exception. 
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to a new (not upgraded) domain configured for the RDBMS Security Store, see the 
details on migrating data from the old security store to the new security store in 
"Upgrading a Domain to Use the RDBMS Security Store" in Oracle Fusion Middleware 
Securing Oracle WebLogic Server. 

1.7 Event Handling
Events can target content to a desired audience. 

If you created a separate behavior tracking database in version 8.1 or 9.2, upgrade it as 
described in Section B.4, "Upgrading Separate 8.1 Behavior Tracking Databases."

Note: As part of the upgrade process, the DDL automatically creates 
the RDBMS Security Store tables in the schema for which the 
p13nDatasource is configured. Oracle recommends that 
administrators use the same database connection settings as the 
p13nDatasource. If a portal domain administrator wishes to use or 
configure a database schema other than the schema for which the 
p13nDatasource is configured, he or she must manually run the 
following script to create the RDBMS Security Store tables for that 
schema:

<WLPORTAL_HOME>/p13n/db/<database_vendor>/rdbms_
security_store_create_tables.sql 

Note: Events will fire for a content repository that was upgraded to 
10.3.2 (unless you turned event tracking turned off at the repository 
level). Events can include repository configuration changes, as well as 
content additions, updates, and deletions to the repository. Events do 
not fire for content in an 8.1 or 9.2 repository that was not upgraded. 
Events are fired for content that is added, updated, or removed from 
that repository. 
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2Upgrading to WebLogic Portal 10.3.2

This chapter describes upgrade tasks related to upgrading your WebLogic Portal 
product to 10.3.2. 

This chapter contains the following sections:

■ Section 2.1, "Before You Begin"

■ Section 2.2, "Database Changes During Upgrade"

■ Section 2.3, "DDL Files"

■ Section 2.4, "Backing Up Your Applications and Data"

■ Section 2.5, "Removing Unneeded Database Objects"

■ Section 2.6, "Upgrading to WebLogic Portal 10.3.2"

■ Section 2.7, "Functional Changes for WebLogic Portal 10.3.2"

2.1 Before You Begin
You can upgrade directly to WebLogic Portal 10.3.2 from 8.1, 9.2, and 10.0/10.2/10.3 
portal applications. For information on upgrading earlier versions to WebLogic Portal 
8.1, see the WebLogic Portal Upgrade Guide for Version 8.1.

2.2 Database Changes During Upgrade
The WebLogic Upgrade Wizard executes database scripts to add and modify database 
tables for WebLogic Portal 10.3.2. Before you run the Upgrade Wizard to perform 
database upgrade tasks, you should perform full backups of all WebLogic Portal 
databases. 

WebLogic Portal 8.1 supports only the Oracle Thin driver. A WebLogic Portal 8.1 
domain that was configured with either the 
weblogic.jdbcx.oracle.OracleDataSource or the 
weblogic.jdbc.oracle.OracleDriver driver is not supported. The domain 
might upgrade successfully, but the following error occurs when you start the server:

<Warning> <JDBC> <BEA-001129> <Received exception while creating connection for 
pool "portalDataSourceAlwaysXA": Invalid Oracle URL specified>

Note: Oracle 8.1.7 (DBMS version and drivers) is no longer 
supported. Upgrade to either Oracle 9i, 10G, or 11G by following your 
vendor's instructions before you upgrade to WebLogic 10.3.2. 
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<Error> <Deployer> <BEA-149205> <Failed to initialize the application
'portalDataSourceAlwaysXA' due to error weblogic.application.ModuleException: - 
with nested exception:
[weblogic.common.ResourceException: Invalid Oracle URL specified]

When you run the 10.3.2 Upgrade Wizard, the default is to automatically upgrade the 
main WebLogic Portal database.

You can choose to defer database upgrades and do them manually. Certain database 
upgrade tasks, such as dropping deprecated database objects, upgrading separate 
behavior tracking databases, and upgrading separate content management databases 
require a manual database upgrade.

For additional information on how to perform database upgrade tasks manually, see 
Appendix B.

2.3 DDL Files
Table 2–1 lists the .SQL files containing the Data Definition Language (DDL) for the 
database upgrade from WebLogic Portal 8.1 to 9.2.

Table 2–2 lists the .SQL files containing the DDL for the database upgrade from 
WebLogic Portal 9.2 to 10.0.

Table 2–1 Files Containing the DDL for Upgrading from 8.1 to 9.2

Directory Name File Name

<WLPORTAL_HOME>/p13n/db/<DBMS> p13n9_create.tables.sql

p13n9_create.indexes.sql

upgrade_fromdbmsauth_
towlssqlauth.sql (if the domain is 
configured for the DBMS authenticator)

dep9_drop_tables.sql (manual upgrade 
only)

<WLPORTAL_
HOME>/content-mgmt/db/<DBMS>

cm9_create_tables.sql

cm9_create_indexes.sql

cm9_create_fkeys.sql

cm9_create_triggers.sql

cmv9_create_tables.sql

cmv9_create_indexes.sql

<WLPORTAL_HOME>/portal/db/<DBMS> pf9_create_tables.sql

pf9_create_fkeys.sql

pf9_create_views.sql

comm_create_tables.sql

comm_create_fkeys.sql

comm_create_indexes.sql

comm_create_views.sql

comm_create_triggers.sql

dep9_drop_tables.sql (manual upgrade 
only)
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Table 2–3 lists the .SQL files containing the DDL for the database upgrade from 
WebLogic Portal 10.0/10.2/10.3 to 10.3.2.

2.4 Backing Up Your Applications and Data
Before you upgrade your application environment, you should manually back up the 
domain and any external application and application database resources in a separate 
process. You should back up the relevant information on all machines in the domain. 
The wizard backs up only the domain directory and does not preserve file 
permissions.

2.5 Removing Unneeded Database Objects
You can clean up an existing database (any database prior to Portal 10.3.2) that 
contains unused and deprecated/removed WebLogic Commerce Services database 
objects.

Run the following scripts to remove the objects from the database:

■ <WLPORTAL_HOME>/portal/db/<DBMS>/wlcs_drop_fkeys.sql

■ <WLPORTAL_HOME>/portal/db/<DBMS>/wlcs_drop_tables.sql

2.6 Upgrading to WebLogic Portal 10.3.2
The upgrade process requires you to upgrade your portal domain and your portal 
application. Upgrading from the following WebLogic Portal versions is supported: 9.2, 
9.2 MP1, 10.0, 10.0 MP1, and 10.2/10.3 applications.

This section contains the following topics:

■ Section 2.6.1, "Upgrading Your Portal Domain"

■ Section 2.6.2, "Upgrading from Portal 9.2 and 10.0/10.2/10.3 to 10.3.2"

■ Section 2.6.3, "Upgrading from Portal 8.1 to 10.3.2"

Table 2–2 Files Containing the DDL for Upgrading from 9.2 to 10.0

Directory Name File Name

<WLPORTAL_HOME>/portal/db/<DBMS> pf10_create_tables.sql

<WLPORTAL_
HOME>/content-mgmt/db/<DBMS>

cm10_create_tables.sql

cmv10_create_tables.sql

Table 2–3 Files Containing the DDL for Upgrading from 10.0/10.2/10.3 to 10.3

Directory Name File Name

<WLPORTAL_HOME>/p13n/db/<DBMS> p13n102_create.tables.sql

p13n102_drop.tables.sql

p13n103_create_tables.sql 

<WLPORTAL_HOME>/portal/db/<DBMS> pf102_create_tables.sql

pf102_drop_tables.sql

<WLPORTAL_
HOME>/content-mgmt/db/<DBMS>

cmv102_create_tables.sql
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2.6.1 Upgrading Your Portal Domain
This section provides upgrade instructions for WebLogic Portal database and metadata 
files. 

As you prepare to upgrade your portal application, review the Oracle Enterprise Pack 
for Eclipse upgrade documentation available by choosing Help > Help Contents > 
Oracle Workshop for WebLogic User's Guide > Upgrading to Workshop for 
WebLogic 10.x. The Oracle Enterprise Pack for Eclipse documentation includes 
step-by-step instructions for using the Import Wizard, and detailed information about 
what happens during the upgrade process and any required manual pre- or 
post-upgrade tasks.

Perform the following steps to upgrade your portal domain:

1. Verify that the WebLogic domain is not running.

2. Upgrade the portal domain using the WebLogic Upgrade Wizard before you 
upgrade your portal application. To start the WebLogic Upgrade Wizard in 
graphical mode and upgrade a WebLogic domain on a Windows platform, run 
upgrade.cmd from the <WLPORTAL_HOME>\common\bin directory

The wizard upgrades your portal, content management, and personalization 
database data. It optionally upgrades your 8.1 RDBMSAuthenticator to the 
WebLogic 10.3.2 SQLAuthenticator. For more information on upgrading your user 
store, see Section 1.6, "Security."

3. Read Appendix A.

4. As needed, upgrade individual applications as described in the Oracle Fusion 
Middleware Production Operations Guide for Oracle WebLogic Portal.

Note: Do not use the menu option Start > All Programs > Oracle 
Products > WebLogic Server 10.x > Tools > Domain Upgrade Wizard. 
This launches the WebLogic Server domain upgrade wizard. 

Note: The WebLogic Upgrade Wizard is described in detail in Oracle 
Fusion Middleware Upgrade Guide for Oracle WebLogic Server. 

Tip: If you customized how you set the domain in your start scripts, 
your changes will be overwritten when you run the WebLogic Portal 
10.3.2 start scripts. You should manually copy any start script (and 
setDomainEnv.cmd/sh) modifications you made and want to preserve 
in the upgraded domain.
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2.6.2 Upgrading from Portal 9.2 and 10.0/10.2/10.3 to 10.3.2
You can upgrade your WebLogic Portal 9.2, 9.2 MP1, 10.0, 10.0 MP1, 10.2, or 10.3 
applications to 10.3.2. The WebLogic Portal APIs have been maintained in this version 
of WebLogic Portal, and most core formats for the database and file based assets have 
not changed. For general information on this type of upgrade, see Section 1.2, "Portal 
9.2, 10.0, 10.2, 10.3 to 10.3.2 Upgrade Overview."

The upgrade process involves upgrading WebLogic Portal applications and resources 
to WebLogic Portal 10.3. The 9.2 and 10.0/10.2/10.3 upgrades are performed on the 
Workshop for WebLogic Eclipse project folder. After you upgrade to Portal 10.3.2, you 
cannot go back to a previous portal version.

Choose one of the following ways to upgrade your Portal 9.2 or 10.0/10.2/10.3 
application to 10.3.2:

■ Open an existing 9.2 or 10.0/10.2/10.3 portal application as a workspace in 
Workshop for WebLogic.

■ Import an existing exploded 9.2 or 10.0/10.2/10.3 project into Workshop for 
WebLogic.

■ Import an archived 9.2 or 10.0/10.2/10.3 project file into Workshop for WebLogic.

Perform the following steps to upgrade a 9.2 or 10.0/10.2/10.3 application to 10.3.2:

1. In Oracle Enterprise Pack for Eclipse, ensure that Project > Build Automatically is 
enabled to resolve any build errors. By default, it is enabled.

2. Upgrade your domain using the WebLogic Upgrade Wizard. For more 
information, see Section 2.6.1, "Upgrading Your Portal Domain."

3. Perform one of the following steps in Workshop for WebLogic to upgrade an 
existing WebLogic Portal 9.2 and 10.0 application:

a. Open an existing portal application as a workspace in Oracle Enterprise Pack 
for Eclipse – Choose File > Switch Workspace, locate the existing workspace, 
and click OK. You can also choose the existing portal application in the 
Workspace Launcher when you launch Workshop for WebLogic, and click OK.

Note: If you are using the RDBMS Security Store feature, as 
described in Section 1.6, "Security," as part of the upgrade process, the 
DDL automatically creates the RDBMS Security Store tables in the 
schema for which the p13nDatasource is configured. If a portal 
domain administrator wishes to use or configure a database schema 
other than the schema for which the p13nDatasource is configured, he 
or she must manually run the following script to create the RDBMS 
Security Store tables for that schema:

<WLPORTAL_HOME>/p13n/db/<database_vendor>/rdbms_
security_store_create_tables.sql 

For more information on the RDBMS Security Store tables, see 
"RDBMS Security Store Tables" in the Oracle Fusion Middleware 
Database Administration Guide for Oracle WebLogic Portal.

Tip: You can choose to point your upgraded application to a new or 
upgraded 10.3.2 domain.
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b. Import an exploded 9.2 or 10.0 project into Workshop for WebLogic – Choose 
File > Import > General > Existing Projects into Workspace, and click Next. 
Click Select root directory, locate the project's directory, and click Finish. 
Click Finish again on the next dialog box to complete the upgrade.

c. Import an archived 9.2 or 10.0 project file (such as a .ZIP file) into Workshop 
for WebLogic – Choose File > General > Existing Projects into Workspace, 
and click Next. Click Select archive file, locate the archive file, and click 
Finish. Click Finish again on the next dialog box to complete the upgrade.

2.6.3 Upgrading from Portal 8.1 to 10.3.2 
WebLogic Portal enables you to upgrade your 8.1 SP4, SP5, and SP6 applications 
directly to 10.3.2. Most WebLogic Portal APIs have been maintained in WebLogic 
Portal 10.3.2 (except for the Commerce API, which was deprecated in 10.0 and 
removed from the current version), and most core formats for the database and file 
based assets have not changed. Where changes have been made, tools are provided to 
upgrade you to the new format, or provide manual changes where needed. For 
general information on this type of upgrade, see Section 1.3, "Portal 8.1 to 10.3.2 
Upgrade Overview."

The upgrade process involves upgrading WebLogic Portal 8.1 portal applications and 
resources to WebLogic Portal 10.3.2. The 8.1 to 10.3.2 upgrade is performed on a 
.work file. When you upgrade from WebLogic Portal 8.1 to 10.3.2, your PointBase 
database is upgraded.

The high-level steps in the upgrade process include the following:

1. Upgrade your domain using the WebLogic Upgrade Wizard. For more 
information, see Section 2.6.1, "Upgrading Your Portal Domain."

2. Upgrade existing WebLogic Portal 8.1 SP4, SP5, and SP6 applications to run in 
WebLogic Portal 10.3.2. You can do this automatically using the Import utility that 
is provided in Workshop for WebLogic. For additional details on importing an 8.1 
appl.ication, see Appendix C.

2.7 Functional Changes for WebLogic Portal 10.3.2
Review the functional changes that are described in Appendix A If any manual 
upgrade tasks are required for your particular environment, perform those tasks as 
instructed. 

Tip: To open an existing portal application as a workspace, ensure 
that the workspace and the application are created and accessed on 
the same machine. The project directory stores non-transferable 
preferences.

Tip: If you customized how you set the domain in your start scripts, 
your changes will be overwritten when you run the WebLogic Portal 
10.3.2 start scripts.
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AFunctional Changes Affecting Your
WebLogic Portal Environment

This appendix describes functional changes in WebLogic Portal 10.3.2 that affect your 
upgraded environment and might require you to perform manual tasks. 

This chapter includes the following sections:

■ Section A.1, "Functional Changes from Portal 8.1 to 10.3.2"

■ Section A.2, "Functional Changes from Portal 9.2 to 10.2/10.3/10.3.2"

A.1 Functional Changes from Portal 8.1 to 10.3.2
The following sections describe changes that occur when you upgrade directly from 
WebLogic Portal 8.1 to 10.3.2. You might be required to perform manual tasks.

This section includes these topics:

■ Section A.1.1, "Upgrading to the SQL Authenticator"

■ Section A.1.2, "Upgrading Federated Portals from 8.1 to 10.3.2"

■ Section A.1.3, "Upgrading UUPs"

■ Section A.1.4, "Understanding JSP Tag Changes"

■ Section A.1.5, "Manually Upgrading Passwords in Content Management 
Repositories"

■ Section A.1.6, "Maintaining Content Queries"

■ Section A.1.7, "Upgrading Look & Feels"

■ Section A.1.8, "Import Wizard Does Not Handle Some Legacy Jar Files"

■ Section A.1.9, "Changes in Behavior Between Struts 1.1 and 1.2"

■ Section A.1.10, "Portlet State Persistence"

■ Section A.1.11, "WSRP Security Compatibility"

■ Section A.1.12, "Working with Encoding in HTTP Responses"

■ Section A.1.13, "Disconnected Desktop Requires desktopStateShared Property"

■ Section A.1.14, "Correcting Duplicate Portlet Category Names in an Upgraded 
Application"

■ Section A.1.15, "Propagation Utility Web Application Obsolete"

■ Section A.1.16, "Definition Labels Not Editable in 10.3.2"
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■ Section A.1.17, "Propagation Inventory Compatibility"

A.1.1 Upgrading to the SQL Authenticator
The RDBMS Authenticator was supported in 8.1, but was deprecated in Portal 9.2 and 
all later releases. The RDBMS Authenticator was replaced by the SQL Authenticator.

To enable support in the Upgrade Wizard for upgrading a domain with an RDBMS 
Authenticator, a manual step is required. Perform the following workaround before 
you upgrade from an 8.1 RDBMS Authenticator to Portal 10.3.2:

1. Update your setDomainEnv.cmd/sh variable 
weblogic.alternateTypesDirectory to include the path to the deprecated 
provider: <WLPORTAL_HOME>/p13n/deprecated/lib/security. 

2. Run the Upgrade Wizard to perform the upgrade. The Upgrade Wizard also 
removes references to the deprecated RDBMS Authenticator from the domain's 
config.xml file.

A.1.2 Upgrading Federated Portals from 8.1 to 10.3.2
New features added in WebLogic Portal 10.0 to support federated portal propagation 
require you to perform the upgrade procedures described in this section.

This section includes the following topics:

■ Section A.1.2.1, "Overview"

■ Section A.1.2.2, "Upgrading Producer and Consumer Applications"

■ Section A.1.2.3, "Upgrading Only the Producer Applications"

■ Section A.1.2.4, "Upgrading Only the Consumer Applications"

■ Section A.1.2.5, "Listing Producer Handles"

■ Section A.1.2.6, "Updating Producer Registration Handles"

A.1.2.1 Overview 
WebLogic Portal 10.3.2 supports features of WSRP 2.0 that permit a more flexible and 
practical approach to propagation of federated portals. With WebLogic Portal 10.3.2, 
the consumer applications in staging and production environments can point to 
separate producers. The primary advantage of this new capability is that you can 
create and modify remote (proxy) portlets in a staging environment in isolation from 
the production environment.

Before WebLogic Portal 10.0, if you wanted to propagate WSRP consumer 
applications, the consumers on the source and destination systems had to point to the 
same producer. This configuration, which is described in detail in the section "WSRP 
Propagation" in the Production Operations Guide for WebLogic Portal 9.2, included several 
limitations. 

This section explains the upgrade procedure for federated portals. The procedures 
described here apply to the following scenarios:

Tip: If you did not upgrade your user store during the domain 
upgrade process, you can perform a manual upgrade later. Run the 
upgrade_fromdbmsauth_tosqlauth.sql script to upgrade from the 
WebLogic Portal-specific RDBMS Authenticator to the WebLogic SQL 
Authenticator. The script is located in the <WLPORTAL_
HOME>\p13n\db\<DBMS>\ directory.
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■ Section A.1.2.2, "Upgrading Producer and Consumer Applications"

■ Section A.1.2.3, "Upgrading Only the Producer Applications" 

■ Section A.1.2.4, "Upgrading Only the Consumer Applications" 

A.1.2.2 Upgrading Producer and Consumer Applications
It is recommended that you upgrade both your consumer and producer applications to 
WebLogic Portal 10.0 in your source (staging) and destination (production) 
environments. Doing so allows you to take advantage of new propagation features 
and simplifies the propagation process. 

1. Upgrade your consumer applications to WebLogic Portal 10.0. Perform the 
upgrade in both the source and destination environments. 

■ If you ever performed a bidirectional propagation (propagated from staging to 
production and then back to staging again) or if propagation fails, you need to 
follow this sub-step. If neither of these conditions applies to you, skip this 
sub-step and proceed to Step 2. 

Obtain the producer registration handles from each consumer application 
from both the source and destination systems. To do this, run the List 
Producers JSP utility as described in Section A.1.2.5, "Listing Producer 
Handles."

2. Upgrade your producer application to WebLogic Portal 10.0. Perform the upgrade 
in both the staging and production environments. 

■ If you ever performed a bidirectional propagation (propagated from staging to 
production and then back to staging again) or if propagation fails, you need to 
follow this sub-step. If neither of these conditions applies to you, skip this 
sub-step and proceed to Step 3. 

Update the producer registration handles. To do this, run the Update 
Registration Handles JSP utility as described in Section A.1.2.6, "Updating 
Producer Registration Handles."

3. Propagate the consumer application from the staging to the production 
environment using the propagation tools. See the Oracle Fusion Middleware 
Production Operations Guide for Oracle WebLogic Portal for information on 
propagation. 

This completes the upgrade process. It is now possible for consumer applications in 
staging and production environments to point to separate producers. 

See the Oracle Fusion Middleware Production Operations Guide for Oracle WebLogic Portal 
for detailed information on propagating portals. 

Tip: When you propagate, you can adjust the scope to include only 
the Portal Framework resources. 

Note: If you want to retain a configuration where consumers in 
staging and production point to the same producer, you can do so; 
however, limitations described in "WSRP Propagation" in the 
Production Operations Guide for WebLogic Portal 9.2 at 
http://download.oracle.com/docs/cd/E13218_
01/wlp/docs92/prodOps/index.html no longer apply. 
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A.1.2.3 Upgrading Only the Producer Applications
If you upgrade your domain and producer application but not the consumers, you 
need to follow the upgrade procedure described in this section. The procedure 
described in this section applies equally whether the consumer application(s) are 
currently at WebLogic Portal 8.1.x or 9.2. 

1. Upgrade your producer application to WebLogic Portal 10.0.

2. Obtain the producer registration handles from each consumer application on both 
the source and destination system. To do this, run the List Producers JSP utility as 
described in Section A.1.2.5, "Listing Producer Handles."

3. Update the producer registration handles for each upgraded producer application 
on the destination system. To do this, run the Update Registrations JSP utility as 
described in Section A.1.2.6, "Updating Producer Registration Handles."

See the Oracle Fusion Middleware Production Operations Guide for Oracle WebLogic Portal 
for detailed information on propagating portals. 

A.1.2.4 Upgrading Only the Consumer Applications
If you upgrade your consumer application(s) but not the producer(s), you need to 
follow the upgrade procedure described in this section. The procedure described in 
this section applies equally whether the producer application is currently at WebLogic 
Portal 8.1.x or 9.2. 

Note: If you upgrade only the producer, you are required to use the 
propagation model described in "WSRP Propagation" in the Production 
Operations Guide for WebLogic Portal 9.2 at 
http://download.oracle.com/docs/cd/E13218_
01/wlp/docs92/prodOps/index.html. In this model, consumer 
applications in both staging and production environments must point 
to the same producer. 

Note: If you upgrade only the producer, you must perform Step 2 
and Step 3 below each time you propagate remote portlets in your 
consumer applications. 

Note: If you want to retain a configuration where consumers in 
staging and production point to the same producer, you can do so; 
however, limitations described in "Portal Propagation" in the 
Production Operations Guide for WebLogic Portal 9.2 at 
http://download.oracle.com/docs/cd/E13218_
01/wlp/docs92/prodOps/index.html will no longer apply. 
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1. Upgrade your consumer applications to WebLogic Portal 10.0. Perform the 
upgrade in both the staging and production environments. 

2. (Optional/Recommended) Obtain the producer registration handles from each 
consumer application on both the source and destination system. To do this, run 
the List Producers JSP utility as described in Section A.1.2.5, "Listing Producer 
Handles."

3. (Optional/Recommended) Update the producer registration handles for each 
upgraded producer application on the destination system. To do this, run the 
Update Registrations JSP utility as described in Section A.1.2.6, "Updating 
Producer Registration Handles."

A.1.2.5 Listing Producer Handles
You can run the List Producer JSP utility (listProducers.jsp) on both the staging 
and production systems on which your consumer applications are deployed. This 
utility obtains the registration handles for producers that have been previously added 
to your consumers.

See the Oracle Fusion Middleware Production Operations Guide for Oracle WebLogic Portal 
for instructions.

A.1.2.6 Updating Producer Registration Handles
You can run the Update Registrations JSP utility (updateRegistrations.jsp) on 
both the staging and production systems. This utility updates the registration handles 
for each consumer application the currently references a given producer.

See the Oracle Fusion Middleware Production Operations Guide for Oracle WebLogic Portal 
for instructions.

Note: If you upgrade only the consumer(s), you are required to use 
the propagation model described in "WSRP Propagation" in the 
Production Operations Guide for WebLogic Portal 9.2 at 
http://download.oracle.com/docs/cd/E13218_
01/wlp/docs92/prodOps/index.html. In this model, consumer 
applications in both staging and production environments must point 
to the same producer. 

Note: If you upgrade only the consumers, steps 2 and 3 are 
recommended each time you propagate your consumer applications. 

Note: If you are currently running a configuration where consumer 
applications in staging and production environments point to the 
same producer, the following steps are optional but recommended. 

Note: If you upgrade only the consumers, steps 2 and 3 are 
recommended each time you propagate your consumer applications. 
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A.1.3 Upgrading UUPs
When you upgrade a Unified User Profile (UUP) from WebLogic Portal 8.1 to 10.3.2, 
the p13n_ejb.jar file is deleted and replaced with a new version of the WebLogic 
Portal 9.2 file. The new p13n_ejb.jar file is packaged in the library modules that 
ship with WebLogic Portal 9.2.

Perform the following steps to upgrade a UUP configured in WebLogic Portal 8.1 to 
WebLogic Portal 9.2:

1. Start Oracle Enterprise Pack for Eclipse and create a new Workspace.

2. Create a new portal domain. Do not create a Portal EAR Project. For instructions 
on creating a new domain, see the Oracle Fusion Middleware Portal Development 
Guide for Oracle WebLogic Portal.

3. Import your Portal 8.1 UUP application into your new environment by choosing 
File > Import.

4. In the Import dialog, open the Other folder, select Workshop 8.1 Application, and 
click Next.

5. In the Application Import dialog, click Browse and locate your 8.1 UUP 
application. Select the .work file and click Open. Verify that the check boxes for 
the UUP application are selected and click Next, as shown in Figure A–1.

Figure A–1 Locate the 8.1 UUP Application

6. In the Source Upgrade dialog, click NetUI Project Upgrader options and select the 
Use WebLogic J2EE Shared Libraries check box. You can also click JSP File 
Migrator options and select the Replace Oracle NetUI tags with Apache Beehive 
tags check box (if desired) and click Finish. 

7. After the upgrade finishes, verify that the following actions occurred:
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■ The p13n-ejb.jar file was removed from the EARContent directory of the 
UUP application.

■ The UUP EJB JAR file (for example, UUPExample.jar) exists in the 
EARContent directory of the UUP application.

■ The UUP EJB JAR file is referenced in a module entry in the 
application.xml file in the <UUPApplication>/EARContent/META-INF/ 
directory.

■ As an example, the cache entry below was added to the 
p13n-cache-config.xml file in the 
<UUPApplication>/EARContent/META-INF/ directory:

<p13n:cache>
     <p13n:name>UUPExampleCache</p13n:name>
     <p13n:description>Cache for UUP Example</p13n:description>
     <p13n:time-to-live>60000</p13n:time-to-live>
     <p13n:max-entries>100</p13n:max-entries>
</p13n:cache>

■ Verify that the User Profile file (for example, UUPExample.usr) file exists in 
the data/src/userprofiles/ directory (or where your Datasync folder 
exists).

8. Associate your portal application with your WebLogic Server by selecting the 
server in the Servers tab, right-clicking the server, and choosing Add and Remove 
Projects. Select the portal application from the Available Projects section, click 
Add, and then click Finish.

9. Build and publish your application. Verify the application by starting the 
WebLogic Server Administration Console and clicking Deployments. Verify that 
the UUP application is active. Then open the UUP application by expanding the 
tree and verifying that the UUP JAR file appears as an EJB.

A.1.4 Understanding JSP Tag Changes
Two JSP tags, <ugm:login> and <ugm:logout>, are deprecated in WebLogic Portal 
9.2 and 10.0. The <ugm:login> and <ugm:logout> JSP tags were moved from the 
ugm_taglib.jar file to the auth_taglib.jar file. 

After you upgrade to 10.3.2, you should use the <auth:login> and 
<auth:logout> JSP tags. The attributes and parameters are the same. 

A.1.5 Manually Upgrading Passwords in Content Management Repositories
After the upgrade is complete, you must manually re-enter the passwords for your 
third-party repositories using the Administration Console; see the Oracle Fusion 
Middleware Content Management SPI Development Guide for Oracle WebLogic Portal for 
more information about editing repository settings.

Until you manually re-enter the passwords for your third-party repositories, you 
cannot access those repositories.

A.1.6 Maintaining Content Queries
In WebLogic 8.1 through WebLogic Portal 8.1 SP5, content query expressions were 
generated differently due to an order of precedence problem. The order of precedence 
was not maintained when executing a content query expression. For example, the 
following expression: (a && (b || c), gets evaluated/executed as (a && b || c). 
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This problem was fixed in Weblogic Portal 10.0 such that the order of precedence is 
now maintained when executing a content query expression. However, if you want to 
continue using the WebLogic Portal 8.1 through WebLogic Portal SP5 query behavior, 
you need to modify your domain scripts to define the following system property: 
-Dwlp.disable.content.rule.fix=true. 

A.1.7 Upgrading Look & Feels
Portal Look & Feels in WebLogic Portal 8.1 used two configuration files for skins and 
skeletons (in the /skins/<skin_name> and /skeletons/<skeleton_name> 
directories): skin.properties and skeleton.properties. Both were text files, 
and skeleton.properties was optional.

In WebLogic Portal 10.0, both files are XML, and both are required.

To upgrade a WebLogic Portal 8.1 Look and Feel to the WebLogic Portal 10.3.2 format:

1. Verify that the portal application that contains the Look and Feel has been 
converted to WebLogic Portal 10.0, as described in the Oracle Fusion Middleware 
Portal Development Guide for Oracle WebLogic Portal.

2. Open the Look & Feel in Oracle Enterprise Pack for Eclipse and re-save it. The 
configuration files are automatically converted to the new XML format.

A.1.8 Import Wizard Does Not Handle Some Legacy Jar Files
The cm_taglib.jar and the pz_compat_taglib.jar are deleted when you 
upgrade and Import Wizard flags all JSPs that refer to these taglibs, which have an 
unsupported taglib URIs. The JSPs will fail. 

The cm_taglib.jar file was not installed by default in a new 8.1 web application, 
but if you added it to your application for backward compatibility, you must handle 
this file manually in your upgraded application. 

Change all references to the cm_taglib.jar and the pz_compat_taglib.jar so 
that they use supported tags and APIs, and delete the obsolete jar files.

A.1.9 Changes in Behavior Between Struts 1.1 and 1.2 
WebLogic Portal support for Struts is slightly different in 10.3.2 if you upgrade to 
Struts 1.2. 

Struts 1.1 support in WebLogic Portal is the same as in previous releases, with the 
struts-adapter taglibs mapped to URIs using web.xml. You can use the 
struts-1.1.war library module instead of the new struts-1.2.war library 
module.

If you are upgrading to Struts 1.2, instead of mapping the struts and struts-adapter 
taglibs using web.xml, WebLogic Portal now relies on the JSP 1.2 implicit taglib 
mapping, wherein any .tld files in the META-INF directory in a JAR are implicitly 
mapped by the web container to the URI specified in the tld. For WebLogic Portal. 
these are in struts-adapter.jar, in the path META-INF/tlds. 

Choose to use one of these two methods to upgrade to Struts 1.2:

■ Modify all JSPs that use the struts taglibs to reference 
http://bea.com/struts/adapter/tags-html and 
http://bea.com/struts/adapter/tags-nested for the HTML and nested 
taglibs, and http://struts.apache.org/tags-* for the remainder of the 
taglibs that our adapter does not override.
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■ Extract the .tlds from both struts.jar (in struts-1.1.war) and from 
struts-adapter.jar (in our portal web library module) and copy them to 
WEB-INF/tlds. This allows for the case where you want to continue using the 
explicit tld mapping via web.xml. 

A.1.10 Portlet State Persistence
In WebLogic Portal 8.1, minimized portlet states were persisted only for the session. 
You can use a workaround, described in the Upgrade Guide for WebLogic Portal 8.1, to 
set up a backing file that controls the states of portlets under the desktop. 

The solution used in 8.1 will continue to work if you depend on this behavior. See the 
Portlet Development Guide for WebLogic Portal 9.2 at 
http://download.oracle.com/docs/cd/E13218_
01/wlp/docs92/portlets/index.html for instructions and an example.

A.1.11 WSRP Security Compatibility 
Producer and consumer applications developed with WebLogic Portal 10.3.2 are 
compatible with producers and consumers developed with WebLogic Portal 8.1. That 
is, a portal developed with WebLogic Portal 10.0 can consume portlets deployed in a 
WebLogic Portal 8.1 domain. Similarly, portlets exposed in a WebLogic Portal 10.3.2 
producer can be consumed by an 8.1 consumer. 

However, if you want to use your own key for the 8.1 or 9.2 consumer, you need to 
follow the procedures outlined the chapter "Establishing WSRP Security with SAML" 
in the Oracle Fusion Middleware Federated Portals Guide for Oracle WebLogic Portal.

A.1.12 Working with Encoding in HTTP Responses 
This section describes changes in how the encoding is set on the HTTP response. 

A.1.12.1 Setting Encoding for 8.1
In WebLogic Portal 8.1, the following methods were used to set the encoding:

1. Examine the .portal file for a directive.page element. If that element is 
present, obtain the encoding from an attribute there.

2. If the element is not present, use the JSP encoding configuration, which looks at 
the <encoding> element in the <jsp-param> section of the web.xml file; the 
default is ISO-8859-1 if these elements are missing.

Both of these mechanisms are now deprecated.

A.1.12.2 Setting Encoding for 10.3.2
See "Working with Encoding in HTTP Responses" in the Oracle Fusion Middleware 
Portal Development Guide for Oracle WebLogic Portal for instructions on setting encoding 
and editing encoding in the IDE.

A.1.13 Disconnected Desktop Requires desktopStateShared Property
For compatibility with 8.1 and prior releases, and to support the few desirable uses of 
a disconnected desktop, WebLogic Portal 10.3.2 provides a new, but deprecated, 
boolean property called desktopStateShared for the StandalonePortletURL 
and the associated JSP tag. You can use this property to retain the previous 
"disconnected desktop" behavior. The default value of this property and attribute will 
be true, causing the portlet to be connected to a desktop. 
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Explicitly setting either the path or contextualPath properties on the URL or tag 
also disassociates the resulting standalone portlet from its originating desktop. This 
also holds true for any URLs generated within the context of the standalone 
portlet—setting path or contextualPath causes the resulting URLs to become 
disassociated with the originating desktop.

A.1.14 Correcting Duplicate Portlet Category Names in an Upgraded Application
In 8.1 and previous releases of WebLogic Portal it was possible, though not 
recommended, to create more than one portlet category with the same name, at the 
same level in the hierarchy. In 10.3.2, this operation is not permitted. (You can use the 
same name for more than one category, but they must not be "peers" in the hierarchy.) 

When you upgrade a portal application to 10.3.2, any duplicate portlet category names 
that were used previously are preserved. It is extremely important that you edit these 
category names to be unique; otherwise the WebLogic Portal propagation tools might 
cause unexpected results, or errors might occur during the propagation process.

A.1.15 Propagation Utility Web Application Obsolete
The Propagation Utility web application, propagation.war, became obsolete as of 
WebLogic Portal 9.2. This application was introduced in a patch for WebLogic Portal 
8.1 SP4 and later incorporated into WebLogic Portal 8.1 SP5. If you are upgrading a 
WebLogic Portal web application in which you previously installed the file 
propagation.war into the root directory of any WebLogic Portal enterprise 
applications, it is recommended that you remove the file before or after upgrading to 
WebLogic Portal 10.3.2. 

A.1.16 Definition Labels Not Editable in 10.3.2 
In WebLogic Portal 8.1, the capability to edit definition labels existed, but was not 
recommended. Modifying the definition label could have unintended implications; for 
example, exposing a protected resource or breaking WSRP (which uses the definition 
label as the portlet handle). 

As of WebLogic Portal 9.2, this functionality has been replaced by a much richer ability 
to move portal resources (books, pages, desktops) between production and 
development environments, without losing user customizations or changing labels. 
These new features include XIP and the propagation utility. XIP allows you to target 
individual portal resources to import and export between development and 
production systems, and you can specify the scope (library, admin, or visitor). For 
more information about WebLogic Portal's propagation tools, see the Oracle Fusion 
Middleware Production Operations Guide for Oracle WebLogic Portal. 

A.1.17 Propagation Inventory Compatibility
WebLogic Portal inventories saved with WebLogic Portal 8.1 or 9.2 cannot be used 
with WebLogic Portal 10.0 propagation tools. 

A.2 Functional Changes from Portal 9.2 to 10.2/10.3/10.3.2
The following sections describe changes that occur when you upgrade from WebLogic 
Portal 9.2 or 9.2 MP1 to 10.2/10.3/10.3.2. You might be required to perform manual 
tasks.

This section includes the following topics:
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■ Section A.2.1, "Upgrading Federated Portals"

■ Section A.2.2, "Upgrading UUPs"

■ Section A.2.3, "Disconnected Desktop Requires desktopStateShared Property"

■ Section A.2.5, "WSRP Security Compatibility"

■ Section A.2.6, "Upgrading Propagation Scripts"

■ Section A.2.7, "Propagation Inventory Compatibility"

A.2.1 Upgrading Federated Portals
The procedure for upgrading federated portals from 9.2 to 10.3.2 is identical to the 
procedure for updating from 8.1 to 10.3.2. See Section A.1.2, "Upgrading Federated 
Portals from 8.1 to 10.3.2" for detailed instructions. 

A.2.2 Upgrading UUPs
Your WebLogic Portal 9.2 or 9.2 MP1 UUP automatically works in WebLogic Portal 
10.3.2. You do not need to upgrade your 9.2 UUP.

A.2.3 Disconnected Desktop Requires desktopStateShared Property
For backward compatibility to WebLogic Portal 8.1 and previous releases, and to 
support the few desirable uses of a disconnected desktop, WebLogic Portal 9.2 
provided a new, but deprecated, boolean property called desktopStateShared for 
the StandalonePortletURL and the associated JSP tag. This property is retained in 
10.3.2 and is still deprecated. 

For more details, see Section A.1.13, "Disconnected Desktop Requires 
desktopStateShared Property."

A.2.4 Re-Index WLP Content
After completing the above sections, you must re-index your WLP content. For 
detailed instructions on re-indexing WLP content, see the Oracle Fusion Middleware 
Autonomy Search Integration Sample Guide for Oracle WebLogic Portal.

A.2.5 WSRP Security Compatibility 
Producer and consumer applications developed with WebLogic Portal 10.3.2 are 
compatible with producers and consumers developed with WebLogic Portal 9.2. That 
is, a portal developed with WebLogic Portal 10.3.2 can consume portlets deployed in a 
WebLogic Portal 9.2 domain. Similarly, portlets exposed in a WebLogic Portal 10.3.2 
producer can be consumed by a 9.2 consumer. 

However, if you want to use your own key for the 9.2, 10.0, 10.2, 10.3, or 10.3.2 
consumer, you need to follow the procedures outlined the chapter "Establishing WSRP 
Security with SAML" in the Oracle Fusion Middleware Content Management SPI 
Development Guide for Oracle WebLogic Portal. 

A.2.6 Upgrading Propagation Scripts
If you created any propagation Ant scripts in 9.2, you must either manually update 
them or regenerate the scripts in 10.0. This change is required because several JAR file 
names have changed and the package name for all propagation Ant tasks has changed.
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If you regenerate your scripts using Oracle Enterprise Pack for Eclipse, the correct 
filenames and package name will be used automatically. If you must update your 
scripts manually (for instance, if you created them manually in the first place), you 
need to make the following changes:

The propagation ant tasks are now located in the package 
com.bea.propagation.ant.taskdefs. 

The following table lists the 9.2 JAR file names and the updated names for 10.0:

A.2.7 Propagation Inventory Compatibility
WebLogic Portal inventories saved with WebLogic Portal 8.1 or 9.2 cannot be used 
with WebLogic Portal 10.3.2 propagation tools.

A.2.8 RDBMS Security Store
WebLogic Server provides the option of using an external RDBMS as a datastore that is 
used by authorization, role mapping, credential mapping, and certificate registry 
providers. WebLogic Portal uses this datastore as part of its default domain 
configuration. When you configure a WLP domain, the RDBMS security store tables 
are automatically created. 

For detailed information on the RDBMS security store, see the WebLogic Server 
document, "Managing the RDBMS Security Store," in Oracle Fusion Middleware Securing 
Oracle WebLogic Server. See also "RDBMS Security Store Tables" in the Oracle Fusion 
Middleware Database Administration Guide for Oracle WebLogic Portal.

Table A–1 Mapping of 9.2 JAR Names to 10.0 JAR Names

9.2 JAR Name 10.0 JAR Name

p13n_prop.jar propagation.jar 

p13n_prop_online.jar propagation_online.jar 

p13n_prop_ant.jar propagation_ant.jar 
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BPerforming Database Upgrade Tasks
Manually

This appendix describes how to perform database upgrade tasks manually if you do 
not use the WebLogic Upgrade Wizard to upgrade from 8.1, 9.2, or 10.0/10.2/10.3 to 
WebLogic Portal 10.3.2.

See the README.txt file and the upgrade_db.properties file in the 
<WLPORTAL_HOME>\common\lib\upgrade\db directory for detailed 
information about the files used in the upgrade and specific upgrade steps.

This appendix contains the following sections:

■ Section B.1, "Upgrading your Main WebLogic Portal 8.1, 9.2, or 10.0/10.2/10.3 
Database"

■ Section B.2, "Upgrading 8.1, 9.2, or 10.0 PointBase Databases"

■ Section B.3, "Upgrading to the 10.3.2 WebLogic Server SQL Authenticator"

■ Section B.4, "Upgrading Separate 8.1 Behavior Tracking Databases"

■ Section B.5, "Upgrading Additional 8.1, 9.2, or 10.0 Content Management 
Databases"

■ Section B.6, "Dropping Deprecated RDBMS Authenticator Tables After Upgrade"

■ Section B.7, "Dropping Deprecated Compoze Database Tables After Upgrade"

B.1 Upgrading your Main WebLogic Portal 8.1, 9.2, or 10.0/10.2/10.3 
Database 

If you did not upgrade your main WebLogic Portal database from 8.1, 9.2, or 
10.0/10.2/10.3 to 10.2.3 using the WebLogic Upgrade Wizard, you can perform the 
upgrade manually. 
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Perform the following steps to upgrade your WebLogic Portal database:

1. Shut down WebLogic Server.

2. Back up your database data as described by your database vendor.

3. Edit the <WLPORTAL_HOME>\common\lib\upgrade\db\upgrade_
db.properties file for your database environment. Replace the @ symbols and 
the text between the symbols with the correct values for @DB_USER@, @DB_
PASSWORD@, @DB_HOST@, @DB_PORT@, and @DB_NAME@.

4. In the upgrade_db.properties file, modify and uncomment the files= 
setting for your portal database. Follow the instructions in the upgrade_
db.properties file for your specific type of upgrade (9.2 to 10.3.2 or 8.1 to 
10.3.2.)

5. Run the following script: upgrade_db.cmd/.sh.

6. If you are upgrading from 8.1 to 10.3.2, run the upgrade_db_data.cmd/.sh 
script to upgrade database data.

7. If you are upgrading a main WebLogic Portal database from 8.1 SP4, SP5, or SP6, 
determine if patch # CR244936 was applied. If this patch was applied, manual 
upgrade of the main WebLogic Portal database is complete. This patch is described 
in WebLogic Portal 8.1 SP5 Release Notes 
(http://download.oracle.com/docs/cd/E13218_
01/wlp/docs81/relnotes/index.html) as follows:

CR237251 – If markup contains more than 4000 bytes, an attempt to store it in the 
database causes an error. If your database does not contain a PF_MARKUP_XML 
table that has been populated with data (for example, Select count(*) from PF_
MARKUP_XML returns 0 rows) and the PF_MARKUP_DEFINITION table does 

Note: As part of the upgrade process, the DDL automatically creates 
the RDBMS Security Store tables in the schema for which the 
p13nDatasource is configured. If a portal domain administrator 
wishes to use or configure a database schema other than the schema 
for which the p13nDatasource is configured, he or she must manually 
run the following script to create the RDBMS Security Store tables for 
that schema:

<WLPORTAL_HOME>/p13n/db/<database_vendor>/rdbms_
security_store_create_tables.sql 

For more information on the RDBMS Security Store tables, see 
"RDBMS Security Store Tables" in the Oracle Fusion Middleware 
Database Administration Guide for Oracle WebLogic Portal.

Note: For PointBase, follow the instructions in Section B.2, 
"Upgrading 8.1, 9.2, or 10.0 PointBase Databases." 

Note: To upgrade your user store, follow the instructions in 
Section B.3, "Upgrading to the 10.3.2 WebLogic Server SQL 
Authenticator."
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not contain the BEGIN_XML and END_XML columns, then this patch was not 
applied.

8. If you are upgrading a main WebLogic Portal database from 8.1 SP4, SP5, or SP6 
and patch # CR244936 has not been applied, run the following script against your 
database:

<WLPORTAL_HOME>\portal\db\<DBMS>\pf9_drop_columns.sql

B.2 Upgrading 8.1, 9.2, or 10.0 PointBase Databases
To manually upgrade your PointBase database from 8.1, 9.2, or 10.0, you must first run 
the WebLogic Upgrade Wizard to perform a domain upgrade, and select No to skip 
the database upgrade. You must also copy the database files themselves (weblogic_
eval.dbn and weblogic_eval$#.wal) into the <WLPORTAL_
HOME>\common\upgrade\db directory and then copy them back to the domain 
directory.

See the README.txt file for the specific steps to manually upgrade your PointBase 
database.

B.3 Upgrading to the 10.3.2 WebLogic Server SQL Authenticator
The RDBMS Authenticator was supported in 8.1, but was deprecated in Portal 9.2 and 
all later releases. The RDBMS Authenticator was replaced by the SQL Authenticator.

To enable support in the Upgrade Wizard for upgrading a domain with an RDBMS 
Authenticator, a manual step is required. Perform the following workaround before 
you upgrade from an 8.1 RDBMS Authenticator to Portal 10.3.2:

1. Update your setDomainEnv.cmd/sh variable 
weblogic.alternateTypesDirectory to include the path to the deprecated 
provider: <WLPORTAL_HOME>/p13n/deprecated/lib/security. 

2. Run the Upgrade Wizard to perform the upgrade. The Upgrade Wizard also 
removes references to the deprecated RDBMS Authenticator from the domain's 
config.xml file.

B.4 Upgrading Separate 8.1 Behavior Tracking Databases
If you created a separate behavior tracking database in 8.1, you can upgrade it 
manually.

Perform the following steps to upgrade a separate behavior tracking database:

1. Shut down WebLogic Server.

2. Back up your database data as described by your database vendor.

3. Edit the settings in the upgrade_db.properties file for your behavior tracking 
database. Replace the @ symbols and the text between the symbols with the correct 
values for @DB_USER@, @DB_PASSWORD@, @DB_HOST@, @DB_PORT@, and @DB_
NAME@.

Tip: If you did not upgrade your user store during the domain 
upgrade process, you can perform a manual upgrade later. Use the 
following script to upgrade from the WebLogic Portal-specific RDBMS 
Authenticator to the WebLogic SQL Authenticator: <WLPORTAL_
HOME>\p13n\db\<DBMS>\ upgrade_fromdbmsauth_tosqlauth.sql.
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4. In the upgrade_db.properties file, modify and uncomment the files= 
setting for your behavior tracking database. Follow the instructions in the 
upgrade_db.properties file. 

5. Run the following script: upgrade_db.cmd/.sh. 

B.5 Upgrading Additional 8.1, 9.2, or 10.0 Content Management 
Databases

The default content management database is upgraded automatically. If you created 
an additional content management database in 8.1, 9.2, or 10.0, you can upgrade it 
manually.

Perform the following steps to upgrade an additional Content Management database:

1. Shut down WebLogic Server.

2. Back up your database data as described by your database vendor.

3. Update the settings in the upgrade_db.properties file for your content 
management database. Replace the @ symbols and the text between the symbols 
with the correct values for @DB_USER@, @DB_PASSWORD@, @DB_HOST@, @DB_
PORT@, and @DB_NAME@.

4. In the upgrade_db.properties file, modify and uncomment the files= 
setting for your content management database. Follow the instructions in the 
upgrade_db.properties file. 

5. Run the following script: upgrade_db.cmd/.sh.

B.6 Dropping Deprecated RDBMS Authenticator Tables After Upgrade
After you upgrade to the WebLogic Server SQL Authenticator, you can drop the tables 
associated with the WebLogic Portal RDBMS Authenticator using the following script:

<WLPORTAL_HOME>\p13n\db\<DMBS>\dep9_drop_tables.sql

B.7 Dropping Deprecated Compoze Database Tables After Upgrade
After you upgrade to WebLogic Portal 10.3.2, you can drop the tables associated with 
Compoze/Collaboration using the following script:

<WLPORTAL_HOME>\portal\db\<DMBS>\dep9_drop_tables.sql
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CUpgrading WebLogic Portal 8.1 Projects to
WebLogic Portal 10.3.2

Before you attempt to upgrade a WebLogic Portal 8.1 SP4+ application to WebLogic 
Portal 10.3.2, you need to become familiar with the Oracle Enterprise Pack for Eclipse 
upgrade steps, and any related limitations. For complete information about upgrading 
your portal application in Oracle Enterprise Pack for Eclipse, see the Workshop for 
WebLogic for WebLogic upgrade. 

The Oracle Enterprise Pack for Eclipse upgrade documentation assumes that your 
application was developed using WebLogic Workshop for WebLogic 8.1 SP4+. If it was 
not, you must refactor your code so that it builds and runs in the WebLogic Workshop 
for WebLogic IDE 8.1 SP4+ before using the tools described here to upgrade to 
Workshop for WebLogic 10.3.2.

This appendix focuses on topics that are specifically related to upgrading WebLogic 
Portal applications, and contains the following sections:

■ Section C.1, "WebLogic Portal 8.1 Features Not Supported in WebLogic Portal 
10.3.2"

■ Section C.2, "Upgrade Considerations and Tips"

C.1 WebLogic Portal 8.1 Features Not Supported in WebLogic Portal 
10.3.2

Webflows and pipelines were deprecated in WebLogic Portal 9.2 and are no longer 
supported; use page flows in place of these deprecated features. 

C.2 Upgrade Considerations and Tips
The following sections describe some considerations and tips that might be useful 
when you upgrade portal applications, and it describes some situations where you 
might need to perform some manual tasks after upgrading your portal application. 

This section contains the following topics:

■ Section C.2.1, "Command-Based and Ant Task Upgrade Not Supported"

■ Section C.2.2, "Enabling Communities Features in Upgraded Visitor Tools"

■ Section C.2.3, "Upgrading Look And Feels"

■ Section C.2.4, "Upgrading Custom Controls that Have Custom Properties"

■ Section C.2.5, "Upgrading Tuned Thread Pools for Forked Portlets"
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■ Section C.2.6, "Upgraded Applications Use Struts 1.1 and Related J2EE Libraries"

■ Section C.2.7, "Changes in Behavior Between Struts 1.1 and 1.2"

■ Section C.2.8, "Ampersand Entities in Portal URLs"

■ Section C.2.9, "Upgrading Individual application-config.xml Files Later"

■ Section C.2.10, "Correcting Duplicate Portlet Category Names Before Propagating 
an Upgraded Application"

C.2.1 Command-Based and Ant Task Upgrade Not Supported
Oracle Enterprise Pack for Eclipse provides a command-driven upgrade 
(upgradeStarter) and an ant task-based upgrade. WebLogic Portal does not support 
these upgrade alternatives; you must use the Import Wizard. 

C.2.2 Enabling Communities Features in Upgraded Visitor Tools
Unmodified Visitor Tools code from WebLogic Portal 8.1.4+ is upgraded as part of 
Import Wizard processing. However, the WebLogic Portal 10.3.2 communities-based 
components are disabled by default, because projects developed with 8.1.4+ are not 
communities-aware. 

As part of the upgrade process, the Import Wizard creates a 
communities-config.xml file in the EAR project /META-INF directory that 
defines whether or not the communities-related Visitor Tools are enabled. To enable 
this functionality, set the flag in the enable-community-tools attribute to true, as 
shown in the following example:

<?xml version="1.0" encoding="UTF-8"?>
<communities-config xmlns="http://www.bea.com/ns/portal/100/communities-config">
   <enable-community-tools>true</enable-community-tools>
</communities-config>

C.2.3 Upgrading Look And Feels
Portal Look And Feels in WebLogic Portal 8.1.4+ used two configuration files for skins 
and skeletons (in the /skins/skin_name and /skeletons/skeleton_name 
directories): skin.properties and skeleton.properties. Both were text files, 
and skeleton.properties was optional.

In WebLogic Portal 10.3.2, both files are now XML. 

For WebLogic Portal 10.3.2, it is necessary to use skin.xml and skeleton.xml to 
take advantage of new Look And Feel features, although you can still use legacy 
configurations. Upgrading your old .properties files is required. 

To upgrade a WebLogic Portal 8.1 Look And Feel to the WebLogic Portal 10.3.2 format:

1. Make sure the portal application containing the Look And Feel has been converted 
to WebLogic Portal 10.3.2, as described in this chapter and in the Oracle Enterprise 
Pack for Eclipse documentation.

2. Open the Look And Feel file (.laf file). 

WebLogic Portal automatically upgrades the associated .properties file; 
informational messages describe the change that occurs during upgrade. 
Figure C–1 shows an example:
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Figure C–1 Conversion of Properties File when Look And Feel File is Opened 

3. Click OK to complete the upgrade.

C.2.4 Upgrading Custom Controls that Have Custom Properties
WebLogic Portal 8.1 custom control annotation definitions are not upgraded to 
WebLogic Portal 10.3.2. The means for defining annotations is based on the Java 5 
annotations model. To upgrade controls written for 8.1, you must rewrite the 
annotations definition in keeping with the new model.

For more information on upgrading your custom annotations, take a look at the 
Apache Beehive source code for its system controls. These provide annotations that 
use the new model.

For information on how the control context APIs have changed from WebLogic 8.1, see 
"Handling Context API Changes" in the Oracle Enterprise Pack for Eclipse online help. 

C.2.5 Upgrading Tuned Thread Pools for Forked Portlets
If you optimized the thread pool used for an 8.1 application that uses forked rendering 
or forked pre-rendering, and you want to keep those optimizations in the upgraded 
application, you will need to perform some manual tasks after upgrading. 

WebLogic Portal 10.3.2 uses WebLogic Server's CommonJ WorkManager infrastructure 
for forked portlet pre-render and render. WorkManagers have similar but not identical 
configuration parameters, behavior, and deployment options. When you upgrade an 
8.1.4+ application, any existing customizations to the portalRenderQueue thread pool 
will not be automatically applied to the default WorkManager used for forking. To 
tune this WorkManager, configure a WorkManager and associate it with the name 
wm/portalRenderQueueWorkManager. For more information about 
WorkManagers and thread usage in WebLogic Server 10.0, refer to "Using Work 
Managers to Optimize Scheduled Work" at 
http://download-llnw.oracle.com/docs/cd//E13222_
01/wls/docs100/config_wls/self_tuned.html. 

C.2.6 Upgraded Applications Use Struts 1.1 and Related J2EE Libraries
The Import Wizard includes the Struts 1.1 shared J2EE library for upgraded 
applications. The Struts 1.1 J2EE library is used to maintain the operability of your 
upgraded application; before an upgraded application can use Struts 1.2, any code in 
page flows or portlets with explicit dependencies on Struts 1.1 would need to be 
manually updated. (For more information, refer to Section C.2.7, "Changes in Behavior 
Between Struts 1.1 and 1.2."

For new portal web projects, the Struts 1.2 shared J2EE library is included by default, 
but you can choose Struts 1.1 if desired. Oracle strongly recommends that you keep 
the default setting to use Struts 1.2 with new applications. Even with upgraded 
applications, it would be beneficial to use Struts 1.2 if possible, and you might want to 
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experiment with Struts1.2 to see if any explicit dependencies on Struts 1.1 actually 
exist. 

C.2.7 Changes in Behavior Between Struts 1.1 and 1.2 
WebLogic Portal support for Struts is slightly different if you upgrade to Struts 1.2. 

Struts 1.1 support in WebLogic Portal will be the same as in previous releases, with the 
struts-adapter taglibs mapped to URIs using web.xml. In this case, you should use the 
struts-1.1.war J2EE library instead of the new struts-1.2.war J2EE library.

For applications upgrading to Struts 1.2, instead of mapping the struts and 
struts-adapter taglibs using web.xml, WebLogic Portal now relies on the JSP 1.2 
implicit taglib mapping, wherein any .tld files in the META-INF directory in a JAR 
are implicitly mapped by the web container to the URI specified in the tld. In the case 
of WebLogic Portal, these are in struts-adapter.jar, in the path 
META-INF/tlds. 

You can choose to use one of these two methods to upgrade to Struts 1.2:

■ Modify all JSPs that use the struts taglibs to reference 
http://bea.com/struts/adapter/tags-html and 
http://bea.com/struts/adapter/tags-nested for the HTML and nested 
taglibs, and http://struts.apache.org/tags-* for the remainder of the 
taglibs that the portal adapter does not override.

■ Extract the .tlds from both struts.jar (in struts-1.1.war) and from 
struts-adapter.jar and copy them to WEB-INF/tlds. This allows for the 
case where you want to continue using the explicit tld mapping via web.xml. 

C.2.8 Ampersand Entities in Portal URLs
In past releases, WebLogic Portal used the configuration file 
url-template-config.xml for configuring the form of WebLogic Portal-generated 
URLs. WebLogic Portal now uses the Beehive equivalent: 
beehive-url-template-config.xml. The previous configuration file contained 
an element (generate-xml-amp-entity) that caused URLs to be generated with 
ampersand entities instead of characters for parameter separators, that is:

http://www...?arg1=foo&amp;arg2=bar (entity)

instead of:

http://www...?arg1=foo&arg2=bar (character)

In the absence of this configuration element, URLs were generated with ampersand 
characters.

The Beehive equivalent configuration element for ampersand entities is located in the 
NetUI configuration file, beehive-netui-config.xml. The Beehive default for 
ampersand entities is the opposite of the previous Portal default; in the absence of the 
configuration element, URLs are generated with ampersand entities.

Portal Framework now uses the NetUI configuration file as the source for this 
configuration element, and also uses the Beehive semantics. This means that by 
default, URLs generated by Portal contain ampersand entities. Note that this applies 
only to HTML configurations – XHTML configurations force ampersand entities in 
URLs, regardless of configuration setting.
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If cases exist where you want to ensure that URLs are generated with characters rather 
than ampersand entities, you must add that configuration element to the 
beehive-netui-config.xml file. 

C.2.9 Upgrading Individual application-config.xml Files Later
Applications created using WebLogic Portal Version 8.1.4+ used the file 
META-INF/application-config.xml for configuration of various MBeans. In 
WebLogic Portal 10.3.2, MBeans have been changed to descriptor beans. Settings 
previously contained within application-config.xml are now in the appropriate 
descriptor bean configuration files, including:

■ content-config.xml

■ p13n-config.xml 

■ p13n-cache-config.xml 

■ p13n-security-config.xml

■ wps-config.xml 

When you import a Version 8.1.4+ application into Oracle Enterprise Pack for Eclipse, 
the import process performs the necessary conversion. For individual instances of the 
8.1 application-config.xml file that you might want to use, you can right-click 
the file name in the Package Explorer to access the Upgrade context menu, which will 
convert the file.

C.2.10 Correcting Duplicate Portlet Category Names Before Propagating an Upgraded 
Application

In past releases of WebLogic Portal it was possible, though not recommended, to create 
more than one portlet category with the same name, at the same level in the hierarchy. 
In WebLogic 10.3.2, this operation is not permitted. (You can use the same name for 
more than one category, but they must not be "peers" in the hierarchy.) 

When you upgrade a portal application to 10.3.2, any duplicate portlet category names 
that were used previously are preserved. It is extremely important that you edit these 
category names to be unique; otherwise the WebLogic Portal propagation tools might 
cause unexpected results, or errors might occur during the propagation process. 
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